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CHAPTER 1: INTRODUCTION
General
Congratulations on your purchase of one of the most cost effective pieces of
land speed racing equipment that is presently available - Bonneville Pro.
Today, in this 21st century, the sport of automobile racing has attained a
level of sophistication that makes the personal computer an important tool
for every racer to use, Professional and Sportsman alike.
Now, Bonneville Pro unlocks the power and convenience of the PC for every
land speed racer who wants to understand and improve the performance of
their own vehicle.
The winning racecar combination is the quest of all racers. "What rear end
gear should I run? Which transmission ratios? What size tires? What stall
speed converter? When should I shift?"
These are but a few of the many decisions a racer must make when setting
up a new racecar, or when trying to make an existing vehicle faster and more
consistent.
In the past, the approach has usually been to copy what the next guy has, and
then start changing things, one at a time.
This is a costly, time consuming process which usually ends up with a worn
out vehicle and a shop or garage full of worthless spare parts.
You can't afford to try everything at the same time and varying track
conditions can cloud the results of even the best back-to-back testing.
With competitive land speed racing being a contest of tenths of a mile per
hour, only a computer can provide the necessary consistency and accuracy to
optimize your vehicle's top speed performance.

RSA (Racing Systems Analysis) was started in 1978 by Patrick Hale, a
local drag racer from Arizona. After drag racing several vehicles while
attending Mechanical Engineering school at Arizona State University; he
developed a computer model for quarter-mile vehicle performance analysis.
Access to powerful computers was limited in those days, so only the services
of the computer program could be marketed, and therefore its general use
was limited.
Today, the widespread availability of the PC has made this powerful
computer program, Bonneville Pro, available to everyone.
The services of RSA are also available to customize Bonneville Pro to your
specific needs; or to write new, engineering analysis type software for other
applications. Give RSA a call or e-mail. We will be happy to discuss these
possibilities, and future RSA products with you.

Web: www.QUARTERjr.com

Installing your program disk
1. Start by inserting the Bonneville Pro program CD into the appropriate
drive in your PC.
2. Use the mouse to select Run from the Start menu.
3. In the Command Line box, type d:setup.exe depending on which drive
you are using to read the Bonneville Pro setup disk.
4. Use the mouse to click the OK button.
5. Follow the instructions displayed on your computer monitor. When you
are finished, remove the CD.
6. The setup process creates a folder named Bonneville Pro in the Program
Files group. This folder contains the icon for the Bonneville Pro software
and the sample data documents. The Bonneville Pro program icon has the
name BvPro.exe.
7. You can now create a Shortcut for the BvPro.exe file and Send it to the
desktop if you like. You normally do this by right-clicking the mouse on the
BvPro.exe program icon and then choosing Create Shortcut from the dropdown list.

CHAPTER 2: SAMPLE Bonneville Pro ANALYSIS
Getting Started
In this chapter, we will walk you through a sample, hands on, vehicle
performance analysis. So please sit at your computer while you read this
chapter. Bonneville Pro is designed to be very easy to use, even for the first
time or novice computer user.
You can begin using Bonneville Pro in one of two ways. For now, use the
mouse to double-click on the application icon in the Bonneville Pro folder or
the desktop Shortcut you created for BvPro.exe. This action starts loading
Bonneville Pro from the hard disk to the random access memory (RAM) and
starts the program running.
The splash screen identifying the version of the Bonneville Pro program you
have will now appear. This will be followed by the Bonneville Pro Input
Data screen including a menu of commands. By choosing one of the menu
items from the menus (File, Timeslip, Graph, Window and Help), you
command Bonneville Pro to do whatever you choose.
Bonneville Pro can also be started by double-clicking on any data document
that you have created and saved.
By double-clicking on a data document you can pick right up where you left
off! However, to use this optional method you must first "register" the
Bonneville Pro application file with the "*.dat" data file type using the
Windows "File Types" manager.
The Windows "File Types" manager is selected by double-clicking on "My
Computer" and selecting "Options" from the "View" command menu.
The tab for setting the application "File Types" can now be selected.
Sample Bonneville Pro Analysis
To begin with, select and then open the GasCoupe.dat Bonneville Pro data
document. Now, let's take a quick look at the Bonneville Pro Input Data

screen. The Input Data screen contains all the data necessary to perform the
performance calculations.
General information about the weather conditions, and the weight,
transmission gear ratios and aerodynamics of the vehicle are included. There
are engine power inputs from the dyno and clutch data, transmission gear
ratios, final drive ratio, and tire size!
Any of these input data values may easily be changed using the editing
features of Bonneville Pro which are fully described in Chapters 3 and 4 of
this manual.
Now slowly press the tab key a few times and watch how the cursor moves
around the Bonneville Pro Input Data screen. When you get to the Engine
Dyno Data and Transmission Gear Ratios you must use the arrow keys to
navigate instead.
You can also use the mouse to select any input variable to modify. Singleclicking on the variable value allows you to insert and delete. Doubleclicking allows direct replacement of the input variable value.
Now press the Timeslip button (the command button with the dark green
TS) to begin the detailed calculations for the vehicle top speed based on the
current data.
After a second, the calculations are complete, and the Timeslip is displayed.
A detailed description of all the Calculated Output from Bonneville Pro is
included in Chapter 5 of this manual.
Press the Detailed Parameters button located at the bottom of the Timeslip.
This screen shows all the vehicle Detailed Parameters, including time,
distance, acceleration and engine RPM.
Press one of the Vehicle Performance Graph buttons located to the right of
the Print button. These graphs show the Detailed Parameters just like you
get them from an expensive on-board data recorder!

That's all there is to it! You can now return to the Bonneville Pro Input
Data screen by closing the Timeslip, Detailed Parameters and Vehicle
Performance Graph screens - simply click the mouse on the close box in
the upper right hand corner.

Or you can use the mouse to click anywhere on the Bonneville Pro Input
Data screen and the other open screens will be closed automatically. You
can also go the Window: drop-down command menu and select the Input
Data screen.
Now, try changing the Frontal Area to 15 square feet, and then press the
Timeslip button to obtain the Timeslip for this smaller frontal area.
How much quicker does the GasCoupe racecar go? Is the engine RPM too
high at the end of the track? (Press the Detailed Parameters and RPMMPH vs Time graph buttons to find out!) Maybe the final drive gear ratio
needs changing? Perhaps taller tires will do the trick?
These are the types of questions Bonneville Pro was designed to answer,
quickly and economically, without ever having to go to the track to test!
Bonneville Pro also includes powerful calculation worksheets available by
pressing any one of the three Worksheet buttons at any time. The
Worksheet buttons are located next to their corresponding input variables
and have a ... symbol on them. Try pressing the Frontal Area Worksheet
button located at the Frontal Area input variable location now.
The Frontal Area Worksheet will be displayed for easily calculating the
vehicle frontal area. The Frontal Area Worksheet variables are described
starting on page 4-15 of this manual.
The frontal area is automatically calculated as you enter the worksheet data.
Press the close box in the upper right-hand corner to return to the Bonneville
Pro Input Data screen when you are finished using the worksheet.

Note that the calculated frontal area from the worksheet does not
automatically transfer to the Bonneville Pro Input Data screen. You must
still input any new value for yourself.
Bonneville Pro also includes help screens available by pressing one of the
two Help buttons at any time. The Help buttons are located next to their
corresponding input variables and have a ? symbol on them. Try pressing
the Traction Index Help button located at the Traction Index input
variable location now.
The Traction Index help screen is included with Bonneville Pro to
conveniently illustrate the choices available for the input Traction Index.
Press the close box in the upper right-hand corner of the help screen to return
to the Bonneville Pro Input Data screen.
Selecting the Exit command from the File menu (or typing Control+X) will
return your computer to the desktop.
Good luck and have fun! The remaining chapters of this manual provide
you with the detailed knowledge and skills necessary to fully exploit the
power and versatility of Bonneville Pro and your PC.

CHAPTER 3: THE COMMAND MENUS
Five command menus; File, Timeslip, Graph, Window and Help,
containing a variety of menu items are used with Bonneville Pro to specify
the command option desired. These menu options may generally be selected
anytime while running the program.
Three of the File menu options - Open, Save and Print are also available by
using command buttons. These are conveniently located just below the
command menu near the top left hand side of the Bonneville Pro Input Data
screen.
The Timeslip and Graph menu options are also available by using several
more command buttons located to the right of the Print command button.
This chapter of the Bonneville Pro manual contains a complete, detailed
description for each of the command menu and button options.
File: Open
The Open command is used to retrieve from the disk and display on the
Bonneville Pro Input Data screen a previously saved Bonneville Pro data
document. Selecting Open from the File menu (or pressing the Open
command button) will cause a standard dialog box to appear, awaiting the
selection of a Bonneville Pro data document.
Once the input data document is selected, the data values are retrieved and
displayed on the Bonneville Pro Input Data screen. The cursor is always
left at the "Note:" position following this option.
The Open command can be used to open an existing data document so that it
may be modified as desired. The retrieved input data can also serve as a
base for building another data document to be saved using the Save As
option described below.
File: Save

The Save command is used to save the current vehicle data on your disk.
Selecting Save from the File menu will save the data using the current
document name. You may also press the Save command button to select this
feature.
File: Save As
The Save As command is used to save the current input data on your disk
with a new document name. You must always select Save As from the File
menu for this command.

File: Print
The Print command is used to make a complete, printed copy of both the
input vehicle data and the Detailed Parameters from Bonneville Pro. The
printout may also contain the data in the Bonneville Pro calculation
Worksheets as well as the Bonneville Pro Vehicle Performance Graphs
depending on your selections from the File: Preferences screen, described
on the next page.
Selecting the Print command in the File menu (or the Print command
button) at any time will cause the printer to start printing.
File: Preferences
The File: Preferences screen is used to select and save Bonneville Pro
options regarding:
1. where the data documents are stored,
2. and how the Calculated Output and Vehicle Performance Graphs are
to be displayed on your printer.
File: Exit
The Exit command in the File menu can be used at any time to exit the
Bonneville Pro program and return to the desktop. You may also exit
Bonneville Pro by pressing the close box in the upper right hand corner of
the Input Data screen.
Timeslip:

The Timeslip command can be used at any time to start the calculations to
determine the vehicle top speed performance. The results of these
calculations will be shown on the Bonneville Pro Timeslip screen.
You may also press the Timeslip command button to select the Timeslip
screen. The Timeslip command button has a dark green TS and is located
just to the right of the Print command button at the top of the Bonneville Pro
Input Data screen.
Graphs:
The Graph menu contains commands that allow the selection and display of
any or all of four graphs that are available from Bonneville Pro:
- RPM & MPH vs Time
- Acceleration and Distance vs Time
- RPM and MPH vs Distance
- Acceleration and Time vs Distance
The Graph menu items and corresponding Graph command buttons may
only be selected after the calculated performance has been completed. The
Graph command options are only enabled after selecting the Timeslip
command.

Window:
The Window menu provides commands for selecting how the Vehicle
Performance Graphs are presented on the computer screen as described
below. The Window menu also provides another way of selecting among
the open Bonneville Pro program screens - just like many other Windows
applications.
In other words, if after viewing the Timeslip screen and some of the Vehicle
Performance Graphs you want to go back to change the Input Data, select
the Window menu with the mouse and then choose the Input Data screen
from the drop down list. This action will automatically close all the
Calculated Output screens.
Window: Cascade Graphs
Normally, the Bonneville Pro Vehicle Performance Graphs are displayed
in a "cascade" fashion as you consecutively select them from the Graph
command menu or by using the Graph command buttons. That is, they
overlay one another in a staggered line-up.
Window: Tile Graphs
The Tile Graphs command in the Window menu resizes the four Vehicle
Performance Graphs and places them side by side on your computer
screen. This option allows you to view all the graphs simultaneously and is
the same format used when printing the Vehicle Performance Graphs to
your printer in the 4 per page format.

CHAPTER 4: INPUT VARIABLES

How to Input
The Input Data screen is where the editing required to build a vehicle data
document takes place. This chapter of the Bonneville Pro manual contains a
complete, detailed description of all the input variables.
Before getting into the definitions of the input variables, let's discuss how
you provide input to Bonneville Pro via your computer keyboard and mouse.
The mouse is used to select the input variable to be changed. Most of the
input variables are edited by selecting them with the mouse and simply
typing in a new value.
If you make a mistake when typing, use the Back Space key to backup and
erase, and then re-enter your data.
Pressing the Tab key (or the Return or Enter keys) signifies the end of the
variable entry. The Tab key will also advance the cursor to the next input
data variable. Pressing the Return or Enter keys will hold the cursor in the
current input variable location.
A maximum of five digits may be input for the numeric variables. If more
than five digits are entered, the excess will be ignored. Only numeric inputs
are allowed.
Also, if you enter a value outside the range of acceptable variable inputs, you
will receive a warning message on the screen and Bonneville Pro will
automatically change the value to be within the established Bonneville Pro
limits.
Some of the data values are determined by selecting from a drop-down
menu. An example of this type of input is the Fuel System: Simply use the
mouse to click the Fuel System: list box and a menu will appear showing

the possible selections. Click the mouse button on the Fuel System: that
you are modeling.
Some of the data values are determined by selecting option or check boxes.
An example of this type of input is the Torque Converter or Clutch option
located in the Transmission Data. Simply use the mouse to select either the
torque converter or clutch option button.
The remainder of this chapter of the Bonneville Pro manual contains a
complete, detailed description for each of the input vehicle variables. A
complete description of the four Bonneville Pro Worksheets is also included
beginning on page 4-13.
General Data
Note: = A descriptive string of up to 255 characters used to more completely
identify the input vehicle data document.
Elevation = The actual race track elevation above sea level expressed in
feet. Normal input values for the race track Elevation are between 0 and
6,000.
Barometer = The local relative barometric pressure at the race track
expressed in inches of Mercury (in Hg). The "standard atmosphere"
Barometer is normally set at 29.92 in Hg. Normal input values for the
Barometer are between 29.0 and 31.0.
* Notes on Elevation and Barometer Inputs *
The Elevation and Barometer inputs are used to determine the local race
track absolute ambient pressure (psia or in Hg) in Bonneville Pro. "Standard
Atmosphere" conditions are used for this calculation.
You can use "altimeter" for the Elevation, but you must always input 29.92
for the Barometer when doing so.
Never use "relative or density altitude" for the Elevation in Bonneville Pro!

Always input the actual, measured Temperature and Relative Humidity to
Bonneville Pro!
Temperature = The race track outside air temperature expressed in degrees
Fahrenheit (deg F). This value is also known as the "dry bulb" temperature.
Normal input values for the ambient Temperature are between 40 and 110.
Relative Humidity = The local relative humidity at the race track expressed
in percent (%). Normal input values for the Relative Humidity are between
15 and 90.
Wind Velocity = The maximum wind velocity regardless of direction or
orientation to the race track, expressed in MPH. Normal values for the
Wind Velocity are between 0 and 30.
Wind Angle = The angle of the prevailing wind relative to the race track
expressed in degrees. A Wind Angle of 0 represents a direct head-wind and
a Wind Angle of 180 represents a direct tail-wind. Press the Wind Angle
Help button to see other examples for the Wind Angle. Values for the
Wind Angle are always between 0 and 180.
Track: = a drop-down menu to select which race track type is to modeled by
Bonneville Pro.
Traction Index = Specifies the race track traction conditions. The best
traction is obtained for an input Traction Index of 1 and represents the best
traction for asphalt streets. The worst dirt track traction is obtained for a
Traction Index of 15. Press the Traction Index Help button to see some
other examples for the Traction Index.
Vehicle Data
Weight = The total vehicle weight including driver expressed in pounds
(lbs). Normal input values for the vehicle Weight are between 1,200 and
4,000.

Wheelbase = The measured vehicle wheelbase, expressed in inches. Normal
input values for the Wheelbase are between 90 and 300.
Final Drive Data
Gear Ratio = The gear ratio of the final drive. Normal input values for the
final drive Gear Ratio are between 2.0 and 6.0.
note: Use the Motorcycle Final Drive Worksheet described on page 4-13
to determine the overall final drive gear ratio for motorcycles.
Efficiency = The power transmission efficiency of the final drive. The final
drive Efficiency is generally very difficult to obtain, however a well
lubricated, hypoid or spiral bevel gear set typically has a power transmission
loss of between 2 and 3 percent. Normal input values for the final drive
Efficiency are therefore between 0.97 and 0.98.
The Tire Diameter may be input in two ways:
Tire Rollout = The driving tire circumference expressed in inches. This
dimension is obtained by measuring the circumference of a properly inflated
tire without the weight of the vehicle being supported by the tire. Normal
values for the Tire Rollout are between 75 and 118.
Tire Diameter = The driving tire diameter expressed in inches. This
dimension is obtained by measuring the diameter of a properly inflated tire
without the weight of the vehicle being supported by the tire. Normal input
values for the Tire Diameter are between 24 and 37.
Tire Width = The driving tire's "effective" width at the contact patch
expressed in inches. For treaded street tires, the "effective" Tire Width is
determined by subtracting the total width of the tread grooves from the
measured tire width. Normal input values for the Tire Width are between 6
and 18.
note: Use the Tire Width Worksheet described on page 4-14 to estimate
the effective Tire Width for treaded tires.
Aerodynamic Data

The vehicle aerodynamic drag and lift are calculated from the input drag and
lift coefficients, and the frontal area. This is the normal way of calculating
these forces and is consistent with published automotive drag data.
Frontal Area = The frontal (or reference) area to be used with the Drag and
Lift Coefficients to calculate the aerodynamic drag and lift (i.e. down-force)
forces. The Frontal Area is expressed in square feet and is normally the
projected frontal area of the vehicle. Normal input values for the Frontal
Area are between 12 and 28.
note: The Frontal Area can easily be calculated using the Frontal Area
Worksheet described on page 4-15.
Drag Coefficient = Used with the Frontal Area to calculate the vehicle
aerodynamic drag. Press the Drag Coefficient Help button to see examples
for various vehicle body styles from the Bosch Automotive Handbook and
from available racecar data. The Drag Coefficient values are generally very
difficult to obtain, however normal input values are between 0.25 and 0.80.
Lift Coefficient = Used with the Frontal Area to calculate the aerodynamic
down-force exerted on the vehicle. The Lift Coefficient values are very
difficult to obtain, however normal input values are between 0.10 and 0.80.
Engine Dyno Data
The engine dyno data is input as a table of horsepower (or torque) as a
function of engine speed. The engine dyno input is for the "standard"
ambient conditions of sea level elevation, 29.92 in Hg, 60 deg F and no
humidity (i.e. dry air). This is the same "standard" that most aftermarket,
racing and high performance engines are rated at.
A maximum of 11 RPM power points may be input to Bonneville Pro. The
button located next to the lower right hand corner of the Engine Dyno Data
table may be pressed at any time to graphically display the input HP and
torque curves vs RPM. Pressing the close box in the upper right hand corner
of this screen will return you to the Bonneville Pro Input Data screen.

The engine dyno data is "referred" to the local race track conditions specified
by the General Data, based on the SAE (Society of Automotive Engineers)
J1349 Standard method for the Bonneville Pro performance analysis.

RPM = The engine speed expressed in revolutions per minute (RPM).
Normal input values for the engine dyno data RPM are between 2,000 and
12,000. A blank or zero input indicates the end of the engine power table
inputs.
HP = The engine power expressed in horsepower. Normal input values for
the engine HP are between 200 and 6,000. The corresponding Torque for
the input HP is automatically calculated and displayed by Bonneville Pro.
Torque = The engine torque expressed in ft-lbs. Normal input values for the
engine Torque are between 150 and 5,000. The corresponding HP for the
input Torque is automatically calculated and displayed.
Fuel System: = a drop-down menu to select which type of fuel and fuel
system are to modeled by Bonneville Pro.
HP/Torque Multiplier = A multiplier on the engine dyno data. This
multiplier can be used to easily modify the input engine dyno data to match a
known vehicle performance level or to perform a sensitivity study. Normal
input values for the HP/Torque Multiplier are between 0.9 and 1.1.
Recalc = Pressing the Recalc button will cause all the HP and Torque data
values to be recalculated using the current HP/Torque Multiplier. The new
values will be displayed in the engine dyno data table, and the HP/Torque
Multiplier will be reset to 1.0.
Transmission Data
Either a torque converter or clutch type transmission may be modeled with
Bonneville Pro. The Transmission Data inputs described below are used
for either of these vehicle powertrain configurations. The Torque
Converter and Clutch option buttons determine which inputs are used.

Clutch & Manual Transmission
Slip RPM = The minimum engine RPM observed as the vehicle leaves the
starting area in low gear. This is the engine RPM below which the clutch
will normally slip. This is not the engine RPM the car is launched at, but
rather the engine RPM when the vehicle starts to move. Normal input values
for the clutch Slip RPM are between 2,000 and 7,000.
Clutch Slippage = A small amount of clutch slippage normally occurs even
when the clutch is locked up and the engine speed is above the Slip RPM.
Normal input values for Clutch Slippage are between 1.00 and 1.02.
Lock-up option? = An option check box to command Bonneville Pro to
completely lock-up the clutch during the shifts.

Torque Converter & Automatic Transmission
Stall RPM = The stall or "flash" speed of the torque converter. The Stall
RPM is the engine speed at which torque multiplication can occur in the
torque converter. Normal input values for the torque converter Stall RPM
are between 2,000 and 7,500.
Converter Slippage = Normal torque converter slippage occurs when the
engine RPM is above the Stall RPM. The torque Converter Slippage may
be available from the manufacturer. Normal input values for the torque
Converter Slippage are between 1.03 and 1.08. High-stall torque
converters generally have higher Converter Slippage than low-stall torque
converters.
Lock-up option? = An option check box to command Bonneville Pro to
completely lock-up the converter after the first shift.
Torque Multiplication = The torque multiplication factor of the torque
converter. This value is achieved when the output speed of the torque
converter is 0 RPM, while the input (engine) speed is the Stall RPM. The
Torque Multiplication factor may be available from the manufacturer.
Normal values for the Torque Multiplication are between 1.4 and 2.0.

High-stall torque converters generally have lower Torque Multiplication
than low-stall torque converters.
The transmission Gear Ratio data is input for each gear or speed of the
transmission. A maximum of six gears may be input.
Gear Ratio = The cumulative transmission gear ratios for each gear of the
transmission. Usual input values for the transmission Gear Ratio are around
3.0 for low gear and 1.0 for high gear. A blank or zero input value indicates
the end of the transmission gear ratio inputs.
Efficiency = The cumulative transmission efficiencies for each gear of the
transmission. The transmission Efficiency is generally very difficult to
obtain, however a well lubricated, straight cut or planetary gear set typically
has a power transmission loss of between 0.5 and 1.0 percent per gear set.
Normal input values for the transmission Efficiencies can vary from 0.96 in
low gear to 0.99 in high gear depending on the specific transmission
configuration being modeled.

Shift@ = The engine speed when gear changes or shifting are to occur,
expressed in revolutions per minute (RPM). Normal input values for the
engine Shift@ are between 4,500 and 12,500.
Motorcycle Final Drive Worksheet
The Motorcycle Final Drive Worksheet is selected by pressing the
Motorcycle Final Drive Worksheet button located at the Gear Ratio input
variable position, but only for vehicles weighing less than 800 lbs. Control
is returned to the Bonneville Pro Input Data screen by pressing the close
box when you are finished using the worksheet.
The Motorcycle Final Drive Worksheet is included with Bonneville Pro to
help you quickly calculate the overall final drive Gear Ratio for your
motorcycle. Each of the Motorcycle Final Drive Worksheet variables are
fully described in the following paragraphs.

Primary Drive Gear Reduction = The gear reduction between the
motorcycle engine crankshaft and transmission mainshaft. Normal values
for the Primary Drive Gear Reduction are around 1.8.
Countershaft Sprocket Teeth = The number of teeth on the countershaft
sprocket. Normal values for the Countershaft Sprocket Teeth are between
12 and 18.
Rear Wheel Sprocket Teeth = The number of teeth on the rear wheel
sprocket. Normal values for the Rear Wheel Sprocket Teeth are between
40 and 50.
Tire Width Worksheet
The Tire Width Worksheet is selected by pressing the Tire Width
Worksheet button located at the Tire Width input variable position.
Control is returned to the Bonneville Pro Input Data screen by pressing the
close box when you are finished using the worksheet.
The Tire Width Worksheet is included with Bonneville Pro to help you
quickly estimate the "effective" Tire Width for treaded street-type tires.
Each of the Tire Width Worksheet variables are fully described in the
following paragraphs.
Tread Width = The measured overall tread width, expressed in inches.
Normal values for the Tread Width are between 6 and 12.
Number of Grooves = The number of grooves in the treaded street-type tire.
The Number of Grooves varies considerably but is usually less than 10.
Each Groove Width = The measured width of each individual tread groove,
expressed in inches. Normal values for Each Groove Width are between
.125 and .25.
Frontal Area Worksheet

The Frontal Area Worksheet is selected by pressing the Frontal Area
Worksheet button located at the Frontal Area input variable position.
The Frontal Area Worksheet is included with Bonneville Pro to help you
quickly estimate the projected frontal area for your vehicle. The Frontal
Area Worksheet variables are fully described below.
Maximum Width = The measured width of the vehicle at it's widest point,
expressed in inches. Normal values for the Maximum Width are between
48 and 72.
Maximum Height = The measured distance from the ground to the highest
point on the vehicle, expressed in inches. Normal values for the Maximum
Height are between 40 and 60.
Shape Factor = A factor to help determine the actual vehicle frontal area
expressed in percent (%). The projected frontal area is never a pure
rectangle defined simply by the Maximum Width and Maximum Height.
There are always corners, gaps and sloping side surfaces. The Shape Factor
specifies how much of the pure rectangular area is really blocking the air.
Press the Shape Factor Help button to see examples for the Shape Factor.
Normal values for the Shape Factor are between 65 and 90.

CHAPTER 5: CALCULATED OUTPUT
The calculated output from Bonneville Pro is very comprehensive and is
divided into three parts - the Timeslip, Detailed Parameters, and the
Vehicle Performance Graphs. Please refer to the output of the sample case
on you computer monitor to get a complete understanding of all the
Bonneville Pro calculated output.
Timeslip
The Bonneville Pro Timeslip contains a summary of the calculated vehicle
speed data at a number of fixed locations on the input race Track: type.
Detailed Parameters
The Bonneville Pro Detailed Parameters contain all the calculated vehicle
performance data in a tabular format. These data include the Time, Distance,
MPH, Acceleration, Gear, and RPM for many, many positions on the input
race Track: type.
Each line of Detailed Parameters corresponds to a specific event or trigger
that caused Bonneville Pro to print to the screen. These events and triggers
are thoroughly explained in this chapter of the Bonneville Pro manual.
The first line of the Detailed Parameters is for the initial conditions; time,
distance, and speed are zero. The vehicle is in 1st gear with the engine speed
equal to the Slip/Stall@ RPM. The rate of acceleration in g's is displayed
for this condition.
**Note: 1g = 32.174 ft/sec/sec
Note the small (s) to the right of the Acceleration value for the first line of
the sample GasCoupe Detailed Parameters. This indicates that the tires are
simply not capable of transmitting all the tire torque the engine and overall
gear ratio are providing at this point. Having several lines with an (s) is
usually unacceptable for actual on-track operation.
The second and third lines of the sample GasCoupe Detailed Parameters
are the result of a gear change event. The engine speed is at the Shift@

RPM in 1st gear on the second line, and at a reduced engine speed in 2nd
gear on the third line.

The remaining gear changes will also trigger two lines of vehicle
performance data on the Bonneville Pro Detailed Parameters screen.
The sixth line is the result of a speed match trigger. Bonneville Pro provides
output for the popular 0-60 MPH and 0-100 MPH or 0-100 MPH and 0-200
MPH timing intervals.
The last several lines of the sample GasCoupe Detailed Parameters are the
result of distance triggers specific to the input race Track: type.
Bonneville Pro will also sometimes select a time interval for Detailed
Parameters print between 10 and 50 seconds. Detailed vehicle performance
data are also provided at regular multiples of this selected time interval.
In summary, several events or triggers are used to generate Bonneville Pro
Detailed Parameters. These include distance, gear changes, speed matches,
and elapsed time intervals. Thousands of intermediate calculations are
performed between each of the lines displayed on the Bonneville Pro
Detailed Parameters screen.
The Detailed Parameters are included to give you a complete record of the
vehicle performance data during a run, just like you get from an on-board
data recorder.
Vehicle Performance Graphs
The Vehicle Performance Graphs display the Bonneville Pro calculated
Detailed Parameters in a graphical, sometimes more easy to understand
format. Any combination of the following four graphs may be displayed
after the calculated performance is completed:
- RPM & MPH vs Time
- Acceleration and Distance vs Time

- RPM and MPH vs Distance
- Acceleration and Time vs Distance
The Vehicle Performance Graphs always show two sets of data plotted
against either time (in seconds) or distance (in miles).
For example, the RPM & MPH vs Time graph includes an RPM axis on the
left side of the graph, and a MPH axis on the right. The x-axis, located along
the bottom is for time. This graphical format is just like you get from an onboard data recorder.
The graph legend highlights which color is used for each data set - blue for
the left axis (RPM in this case) and red for the right axis (MPH in this case).
This same graphical format is used for all four of the Bonneville Pro Vehicle
Performance Graphs.

